1) Ubertragen Sie die Turtle-Moduldatei "tns" auf lhre
Tl-:Rechner der Nspire CX llI-Familie

Nach dem Herunterladen der Zip-Datei und dem
Extrahieren der Dateien:

Offnen Sie lhre TI-Nspire CX Desktop Software.
SchlieRen Sie Ihre TI-Nspire CX II-Taschenrechner
Uber das Computer-zu-Taschenrechner USB-Kabel,
das mit dem Taschenrechner geliefert wird, an

Ihren Computer an.

Stellen Sie sicher, dass der verbundene Rechner im
Fenster ,Verbundener Handheld® auf der
Registerkarte Inhalts-Explorer der Desktop-
Software angezeigt wird.

Ubertragen Sie die Turtle "tns" -Datei auf den
angeschlossenen Taschenrechner, indem Sie die
Datei in das Fenster Connected Handheld ziehen.
Nachdem Sie die Datei auf Inrem Taschenrechner
geoffnet haben, fahren Sie mit Schritt 3)
Installieren des Turtle-Moduls fort.

Dieser Schritt bendtigt zwingend die TI-Nspire CX Desktop

Software fur PC oder Mac

Tiam e slected 73348

Press menu

Alternativ (funktioniert nur mit Chrome-Books):
Verwenden Sie das kostenlose TI-Nspire CX ||
Connect Programm (https://nspireconnect.ti.com/),
um die Turtle "tns"-Datei auf einen TI-Nspire CX Il
zu Ubertragen, der mit dem Computer-zu-Handheld-
USB-Kabel an den Computer angeschlossen ist.

Hinweis: Die Turtle "tns" -Datei kann vor der Installation
auch tUber die Verbindung von Einheit zu Einheit mittels
USB-Kabel von Handheld zu Handheld tbertragen
werden.

Gehen Sie nun zu Schritt 3) und Installieren Sie
das Turtle-Modul.
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2) Ubertragen Sie die Turtle-Moduldatei "tns" auf lhre
Desktop-Software (PC oder Mac).

Nach dem Herunterladen der Zip-Datei und dem
Extrahieren der Dateien:

. Ziehen Sie die Turtle "tns"-Datei per Drag & Drop
auf lhre TI-Nspire CX Il Desktop-Software.
. Nachdem die Datei geéffnet wurde, fahren Sie mit

Schritt 3) Installieren des Turtle-Moduls fort.

3) Installieren des Turtle-Moduls
Mit diesen Schritten wird das Modul auf dem
Taschenrechner installiert. Dieselben Schritte werden
auch verwendet, um das Modul auf der Desktop-
Software zu installieren.

1. Offnen Sie die Turtle-Datei und lesen Sie die
Anweisungen auf der Seite 1.1 .
2. Dricken Sie [Ctrl] + [~], um zur Python-Shell auf

Seite 1.2 zu wechseln.

3. Dricken Sie [Menl] und wéahlen Sie Extras > Als
Python-Modul installieren.

4. Nach der Installation erscheint die Meldung
"Installation abgeschlossen”, die die Installation
bestatigt.

Hinweis: Nach der Installation wird die Turtle-
Moduldatei in den Pylib-Ordner verschoben.

Ti-Nspire CX Il Python Turtle Graphics ©
Module Installation Directions:
1. Select [ctri}+[»] to switch to the Python shell on

2. Select [menu] -> Tools —> Install as Python

complete” will appear, and the original file 15
moved to the PyLib folder.

12
Python Shell

n

>>>|

Letztes Programm wiederholen (Ctrl+R)
Zu Python-Editor wechseln

Shell erneut initialisieren

Von PROGRAMM import *...
8 Als Python-Modul installieren

A Python Shell

>>>

Installation abgeschlossen

turtle.tns wurde als Modul installiert




4) Zugriff auf die Mentauswahl des Turtle-Moduls
Nachdem das Turtle-Modul die Installation
abgeschlossen hat, missen Sie ein neues Dokument
erstellen, um ein Turtle-Programm zu schreiben.

1. Wahlen Sie auf dem Startbildschirm Neu aus.
Wahlen Sie Python hinzufiigen, Neu...

3. Geben Sie dem Python-Programm einen Namen
(Beispiel: quadrat) und driicken Sie OK.

N

Jetzt befinden Sie sich auf einer Python-Programm-
Editor-Seite.

4. Dricken Sie die [Menu]-Taste und wahlen Sie
Weitere Module > Turtle Graphics

Nun kénnen Sie mit dem Schreiben eines Python-
Programms beginnen.

Hinweis: Die abgebildeten Menus kénnen bei lhnen
etwas anders aussehen.

o

CAS

Scratchpad Dokumente

x =
e,

VI BB A

Calculator hinzufugen

Graphs hinzuftugen

Geometry hinzufugen

Lists & Spreadsheet hinzufiigen
Data & Statistics hinzufugen

Notes hinzufugen

Vernier DataQuest™ hinzufugen
Widget hinzuftgen
Programmeditor hinzuftigen

2 Offnen...
3 Shel

A quadrat.py 1M
neu |
Name: quadrall
Typ: | Leeres Programm "
OK | Abbruch
% 1 Aktionen 4
P 2 Starten 4 11
Ed 3 Bearbeiten '
1. 4 Eingebaute 4
3 Move L4t
é : ;Auigtl(;zahl 3 Draw » Komplexe Mathematik »
* |4 Pen control » Time 4
1 7 TIPlotLib 3 Ti System * |5 Settings » Tl System »
:3 T Hub 4 T Draw * |6 Tell Tuttle's state » T!Draw D
5 9 TRover 5 Tjimage " |7 Colors » TlImage b
= 6 BBC micro:bit * |8 Filing * BBC micro:bit »
* B Variablen 7 Turtle Graphics » |9 Commands 4




Erstellen Ihres ersten Turtle-Programms: ein Quadrat zeichnen

Fortsetzung der vorherigen Seite (immer noch im # 1 Aktionen
Editor-Modus): ekl G ‘quedratoy
’ 1 from turtle import * lfrom turtle import *; t=Turtie0
A i i * Move r
1. Wahlen Sie als erstes aus from turtle import < e el
4 Pen control » Time »
5 Settings » Tl System J
2. Durch Driuicken von [Enter] werden diese 3 (T:elllTurth-*s state :1: If:;:‘;‘e X
olors
Importanweisung und der Objekt-Bezeichner 8 Filing + BBC micro:bit »
9 Commands »
t=Turtle() als erste Zeile in Ihr Programm
eingefugt. Dadurch werden die Funktionen und
Methoden des Turtle-Moduls in Ihr Programm
importiert und lhre Turtle als Objekt mit dem
Namen "t" definiert.
3. Hinweis: Bei allen folgenden Mentauswahlen wird
von einem Turtle-Objekt mit dem Namen "t"
ausgegangen. Andert man diesen Objektnamen,
muss diese Anderung auch in allen folgenden
Befehlen beriicksichtigt werden.
W % 1 Aktionen »
D 2 Starten 4 ) 1I> 2 Starten » 3R
. . . . . . E0 3 Bearbeit » if.. —
4. Dr.ucken Sie ein- oder zweimal die Eingabetaste, um zur - E— 3 i else.
Zeile 3 zu gelangen. £ 5 Mathe 3 if.elf.else..
. i . . 6 Zufallszahl 3 Ops » 4 forindex in range(size): k
5. Hinweis: Zeilennummern werden in der oberen rechten L7 TPoLs 4 Listen b 5 for index In range(start, stop):
Ecke der Seit iot 9 8 Tl Huj)bI S At » 6 forindex in range(start, stop, step):
CKe der >elte angezeigt. 6 1/0 » 7 forindex in list:
@ 9 Tl Rover
. 8 while..
6. Driicken Sie [Menii] und wihlen Sie Built-ins, dann LAWY eitei MpdUa 11 9 el
. . var B Variablen 4 A else:
Control und dann for index in range(size):
7. Beachten Sie die Eingabeaufforderung, die das : :
einzugebende Wort hervorhebt *quadrat.py 35| | *quadrat.py 45
. X from turtle import *; t=TurtleO from turtle import *; t=TurtleQ
Durch Driicken der Tabulatortaste werden die
for [AEE in range(Grofie): for seiten in range(d):
Eingabeaufforderungen durchlaufen. Flock .
8. Geben Sie "Seiten" fiir den Index und "4" fiir die
GrofRe ein




9. Driicken Sie mit dem Cursor auf die ; ; g:‘:r‘t’::" ]
Eingabeaufforderung "block” und wéhlen Sie aus B3 Bearbeiten m‘:j;i’ﬁ;’;{) TR
dem [Menii] Weitere Module, dann Turtle 1 from turtte import 7 . _

X X 2 tbackward(distance) | |for seiten in range(4):
Graphics, dann Move und dann die Auswahl 3 Draw 3 tright(angle) tforward (i
t.forward(distance). 4 Pen control 4 tleft(angle)

. . . . . 5 Settings 5 tgoto(x,y)
10. Geben Sie die Entfernung ein, die die Turtle 6 Tel Turle's state 6 t.setheading(angle)
vorwarts fahren soll. 7 EE 7 thomeQ
. .. . . . 8 Filling 8 t.clear(
In diesem Beispiel sind es 75 Einheiten. 9 Commands 9 treset)
Hinweis: Die Entfernungseinheit wird in Pixeln ]
AP . *quadrat.py 56
gemessen. StandardmaRig ist die Rasterskala auf from turtle import % t=Turtle0
I I i for seiten in range(4):
25 Pixel breite Rasterquadrate festgelegt |t.forwa;d(75)
11. Springen Sie zum Ende der Zeile, indem Sie [Tab]
und dann [Enter] driicken, um eine neue Zeile zu
erzeugen.
Befinden Sie sich schon am Zeilenende, reicht ein
einfaches [Enter]. Achten Sie auf die richtige
Anzahl der Einrickungen!
% 1 Aktionen » ]
cken Sie wi 4] und wahien S L 5 [0 v i
12. Driicken Sie wieder [Menu] und wahlen Sie T o e+ 1 iorward(distancey | |10 Ut mport % t=Turtled
Weitere Module, dann Turtle Grafik, dann Move 2 thackward(distance) | |for seiten in range(d):
. . 3 D 3 tri
und dann die Auswahl t.left (Winkel) 3 Pl T | | e
Beachten Sie den "Tooltip", der den Hinweis 5 Settings 5 tgoto(xy) B
"degrees" (Grad) enthélt. 6 Tell Turtle’s state 6 t.setheading(angle)
7 Colors 7 thome(
8 Filling 8 t.clear()
9 Commands 9 treset()
13. Geben Sie den Winkel in Grad ein, in dem die
Schildkrdte nach links abbiegen soll. Fir ein 11
. . *quadrat.py 5/6
Quadrat geben Sie 90 Grad ein. from turtie import % t-Turtle0
for seiten in range(4):
t.forward(75)
14. Springen Sie zum Ende der Zeile, indem Sie [Tab] HefE0)

driicken.

Nun sind Sie bereit, lhr erstes Turtle-Programm
auszufuhren!




15.

16.

Um das Programm auszufihren, driicken Sie
[Men(] und wéhlen Sie dann Starten und
nochmals Starten (alternativ (Ctrl+R)).

Beachten Sie den Shortcut-Hinweis Ctrl+R in der
Meniauswahl. In Zukunft kbnnen Sie einfach die
Tastenkombination Ctrl + R verwenden, um |hr
Programm auszufiihren.

StandardmaRig ist die Schildkréte 4>sichtbar und
Sie sehen, wie sie zeichnet. Wenn Sie mit der
Bewunderung lhrer Arbeit fertig sind, driicken Sie
[Esc], um den Bildschirm zu l6schen und in die
Python-Shell (Seite 1.2) zu wechseln. Driicken Sie
[Ctrl]+[ «], um zur Editor-Seite 1.1
zuriickzukehren. Von dort aus kdnnen Sie lhr
Programm &ndern und erneut ausfihren.

Beachten Sie die Skala in der unteren linken Ecke.

Erweiterungen:

1. Andern der Stiftdicket

2. Andern der Stiftfarbe

3. Turtle-Symbol ausblenden

4. Andern Sie die Geschwindigkeit, mit der sich die
Schildkréte bewegt

5. Ausblenden des Raster- und Skalierungsindikators

6. Fdllen Sie das Quadrat

4 1 Aktionen »
D

E8 3 2 Syntax prufen und speichern (Ctrl+B)
1. 4 3 Gehe zu Shell
V= 5 Mathe b
@ 6 Zufallszahl 4
L2 7 TIPlotLib ’
& 8 Tl Hub 3
@ 9 Tl Rover »
& A Weitere Module »
var B Variablen ’

Python-Shell 3R
>>>#Running quadrat.py

>>>from quadrat import *

>>>|




Turtle Modul - Methoden

Wir haben uns bemdiht, uns an die Syntax und das Ts 556 8
zugehorige Verhalten des Python-API (Application ol o i sl
Programming Interface) fur Turtle Graphics auf der Python [ 241 sirtle —Tuis graphics
Dokumentations-Website zu halten. Obwohl es leichte Ghmm | e il momaicionniied

Verhaltens- und Syntaxunterschiede bei der
Implementierung geben kann, besuchen Sie bitte diese
Website, um sich mit Syntaxdefinitionen und Turtle-
Verhaltensweisen vertraut zu machen.

Imagine & roboti: turle starting at (0, 0)in the x-y piane. Aflor an feport turtle, g0 it the command turtle, Foruard(15), and it
maves (on-screent) 15 pixels in the diraction 4 = facing, drawng a ine a5 4 Moves. Give il e coOmMand turtle. right(25), and it
otates n-place 25 G9grees dockwse.

W"W""M By combinng fogether these and smilar commands, intrcate shapes and

pictures can sasily bs drawn

Turtle star

Turtis can draw infricate shapes using programs that
an extendod rsimplementaton of the same-named ooy S LS

The turtle module is
¥ Python 25,

& ttnes 1o keep the merits of the ok turtie module and to bs (nearly) 100%
compatiie wih 1t This means in tha frst piace to enable tha leamng
programmer o use af the commands, classes and methods mtsractively
‘When using the module from withn [DLE run with the -n swach

The turtle module provides turtle graphics pwuws bnm coject onented
and procedurs onented ways Because &  for the undaryng
Qraphics, it neads a version of Pytnon i stabed i T pt

https://docs.python.org/3.3/library/turtle.html?highlight=turtle

= 85 argument llsllw\abevsedmen E
o sppicaton

sn() relums 8 singieton obiect of 8 TurtleScrasa

Eine Ubersicht tUber Hinweise und bekannte Ausnahmen
finden Sie im Abschnitt Standardeinstellungen und
bekannte Ausnahmen.

Das Hodul ent TR
«  from turtle import * b 2 Siiten { 17
*  Move
 Draw 2 Move .
Komplexe Mathematik »
+  Pen Control 3 Draw ¥
. 4 Pen control » Time 4
»  Settings 5 Settings » Tl System ’
+ Tell Turtle’s state 6 Tell Turtle’s state » Tl Draw ’
+ Colors 7 Colors » TIImag.e . »
. Filli 8 Filling » BBC micro:bit »
fing 9 Commands M
« t.forward(distance) 2 Starten ’ [
. 3 Bearbeiten »
+ t.backward(distance) 1 from turtle import *ETCCIIER 5
+ tright(angle) \ 2 tbackward(distance)
+ tleft(angle) 3 Draw 3 tright(angle)
. 4 Pen control 4 tleft(angle)
t.goto(x,y) 5 Settings 5 t.goto(xy)
+ t.setheading(angle) 6 Tell Turtle’s state 6 t.setheading(angle)
+ t.home() 7 Colors 7 thome(Q
8 Filling 8 t.clear(
* t.clear
0 9 Commands 9 treset)

t.reset()



https://docs.python.org/3.3/library/turtle.html?highlight=turtle
https://docs.python.org/3.3/library/turtle.html?highlight=turtle

Draw

t.circle(radius)
t.dot(radius)
t.stamp()
t.write(“text”)

% 1 Aktionen »
D 2 Starten P 11

3 Bearbeiten

1 from turtle import * :I

2 Move » S
g Dra T

Pen control 2 t.dot(radius) ;
5 Settings 3 tstampQ ’
6 Tell Turtle’'s state 4 twrite("text") b
7 Colors » Tl Image ]
8 Filing » BBC micro:bit 4
9 Commands »

Pen control

t.pencolor(color)
t.penup()
t.pendown()
t.pensize(1,2,0r3)

% 1 Aktionen
D 2 Starten

3 Bearbeiten
1 from turtle import *

2 Move
3 Draw

5 Settings

|

1”n

4
»
»
’

N

» Komplexe Mathematik »

2 t.penupQ
6 Tell Turtle’s state 3 t.pendown(

-

v v v

7 Colors 4 tpensize(1,2,0r3) _*
8 Filling » BBC micro:bit »
9 Commands »
Settings # 1 Aktonen ﬁ
D 2 Startef 4 1,
" Ldegrees() 3 Bearb:ken ’ L
+ tradians() 1 from turtle import * ,
* t.speed(0-10) 2 Move _|
. tshowturtle() 3 Draw 2 tradiansQ ik »
o 4 Pen control 3 t.speed(©-10) ’
+ t.hideturtle() F 4 tshowturtleQ »
* t.setgrid(10-100) Tell Turtle’s state 5 thideturtle ’
+ t.hidescale() 7 Colors 6 t.setgrid(10-100) Y
« thidearid 8 Filling 7 t.hidescaleQ »
grid() 9 Commands 8 thidegrid0 J

version()




Tell Turtle’s state

* var=t.position()

+ var=t.heading()

+ var=t.xcor()

+ var=t.ycor()

+ var=t.towards(x,y)
+ var=t.distance(x,y)
« var=t.isdown()

8 Filling
9 Commands

var=t.position()
var=t.heading()
var=t.xcor()

var=t.towards(x,y)
var=t.distance(x,y)
var=t.isdown(

v vilvlSlv v v

1
2
3
4 var=tycor()
5
6
7

Colors 4 v
— »
+ red Beispiele:
e green t_penco|0r(”red“) 1 from turtle import *
. - » « 2 Move 2 green
bLL:I‘ZW t.fillcolor("green*) i S e athematik »
y 4 Pen control 4 yellow b
*  Cyan S Settings 5 cyan >
* magenta 6 Tell Turtle's state 6 magenta o
. ra 7 gray ’
. glac):/k Filling 8 black it 4
) 9 Commands 9  white ics »
* white
Filling 4
« tfillcolor(color) ;2; g:::::m i 11
*+  tbegin_fill() 1 from turtle import * 4
» tend_fill() 2 Move ’
3 Draw » Komplexe Mathematik »
4 Pen control » Time »
S Settings 4
6 Tell Turtle’s state » Tl Draw ’
7 Colors 2
2 t.begin_fillO »
9 Commands 3 _tend_filo 4
Commands A TR

= while get_key()!="esc"

= sleep(seconds)
= module version()

D 2 Starten

E8 3 Bearbeiten
1 from turtle import *

2 Move

3 Draw

4 Pen control
5 Settings

6 Tell Turtle’s state
7 Colors 1

8 Filling 2
i 3

2 n

»
»

’-
» Komplexe Mathematik »
» Time 4
» Tl System »
»

while get_key() !|= "esc™:
sleep(seconds)
module version()




 Standardeinstellungen und Ausnahmen

Wenn diese Methoden nicht programmgesteuert angegeben werden, werden die folgenden Standardwerte

angewendet.

Turtle

Standardwert: ein. Verwenden Sie t.hideturtle(), um das Turtle-Symbol auszublenden.
Wenn es sichtbar ist, gilt:
1. Die StiftgroRe ist auf 1 festgelegt und kann nicht geandert werden, auch wenn im
Programm eine andere StiftgréR3e angegeben ist.
2. Die Geschwindigkeit kann mit den Argumenten 1 bis 10 angepasst werden.
Bei Verwendung von speed(0) wird das Turtle-Symbol automatisch ausgeblendet.
4. Das Turtle-Symbol kann sich bei der Ausfuihrung langer oder komplexer Programme
zunehmend verlangsamen.
In diesen Féllen ist es am besten, t.hideturtle() anzuwenden.

w

Standardwert: ein. Verwenden Sie t.hidegrid(), um das Raster auszublenden.

Standardwert: 25 Pixel.

Verwenden Sie t.setgrid(), um die Skalierung des Rasters zu andern. Giiltige Argumente sind 10
bis 100.

Verwenden Sie t.hidescale(), um den Skalierungsindikator auszublenden.

Speed

Standardwert: 5

Verwenden Sie t.speed(), um die Geschwindigkeit zu andern. Giltige Argumente sind 0 bis 10.
Wéhrend die Werte 1 bis 10 von langsam bis schnell reichen, ist speed(0) die schnellste (gemaf
der Turtle Graphics API).

Pen

Standarddicke des Stifts: 1. Um die StiftgroRe anzupassen, verwenden Sie t.pensize() mit den
gultigen Argumenten 1, 2 und 3.

Hinweis: Die Stiftgrofe ist immer 1, wenn die Turtle sichtbar ist.

Standardfarbe des Stifts: schwarz. Verwenden Sie t.pencolor(color), um die Stiftfarbe zu
andern. RGB-Werte (Rot, Grin, Blau) sind giltige Argumente fir die Stiftfarbe mit Werten im
Bereich von 0 bis 255. Alternativ kdnnen Sie das Argument t.pencolor(color) mit Auswahlen aus
dem Menu Farbe fillen.

Standardstellung des Stifts: unten. Um die Turtle an einen Ort zu bringen, ohne eine Linie zu
zeichnen, verwenden Sie die penup()-Methode. Die pendow()-Methode muss anschlie3end
angewendet werden, um mit dem Zeichnen fortzufahren.

Fill

Standardfullfarbe: Schwarz. Verwenden Sie t.fillcolor(color), um andere Farben anzugeben.
RGB-Werte (Rot, Griin, Blau) sind gtiltige Argumente fir Fillfarben mit Werten im Bereich von 0
bis 255. Alternativ kdnnen Sie das Argument t.fillcolor(color) mit einer Auswahl aus dem Mend
Farbe flllen.




Beispiel 1: Mein erster Stern

Zeichnen Sie einen einzelnen Stern. Der Stern wird mit einer
zufalligen Linienfarbe gezeichnet und mit einer zufalligen
Farbe gefullt.

Beachten Sie, dass t.pencolor() mit R,G,B-Werten (Rot,
Grln, Blau) im Bereich von 0 bis 255 definiert werden kann.

a sterne.py M7

rom turtle import *; t=Turtle() 5

from random import * .

t.speed(10) Erganzungen:

t. = . . .

yaieat S 1. Andern Sie den t.right()-Winkel, um

t.pendown()

. . . Sterne unterschiedlicher Form zu
t.pencolor(randint(0,255).randint(0,255) ,randint(0,255))

tfillcolor(randint(0.255) randint(0.255) randint(0.255)) erzeugen. Was passiert, wenn der
t.begin_fill) Winkel klein ist oder ergroRer?
while True: . ]
t-forward(160) 2. Andern Sie den Abstand t.forward() fir
t.right(160) . .
ift.heading()<1: immer kleinere Sterne.
break
t.end_fill()

Programm: sterne.tns

Hinweis: Die "break"-Funktion befindet sich derzeit nicht in
einer Menlauswahl und muss von Hand eingegeben
werden. "True" finden Sie unter [men], Built-ins, Ops.




Beispiel 2: Super Nova
Baut auf dem vorherigen Programm auf, nur dass jetzt jede

Sekunde ein neuer Stern erzeugt wird, bis [esc] gedruckt
wird.

|
A sterne.py 1/22

from turtle import *; t=Tur‘tle(ﬂ
from random import *
from time import *
t.speed(10)
t.hideturtle()
t.pensize(2)
while get_key() I= "esc™
t.penup()
t.goto(-80,14)
t.pendown()
t.pencolor(randint(0,255) randint(0,255),randint(0,255))
t.fillcolor(randint(0,255),randint(0,255), randint(0,255))
t.begin_fill()
while True:
t.forward(160)
t.right(160)
if t.heading()<1:
break
t.end_fill()

sleep(1)

\

Programm: nova.tns




Beispiel 3: Sommerblumen

Baut auf den vorherigen Programmen auf, nur dass jetzt
die Position der ,Blumen*® zufallig ist. Mit [esc] wird das

Programm beendet.

from turtle import *; t=Turtle()
from random import *
from time import *
t.speed(0)
t.hideturtle()
t.pensize(1)
while get_key() !="esc":
t.penup()
t.goto(randint(-200,120),randint(-100,100))
t.pendown()
t.pencolor(randint(0,255),randint(0,255),randint(0,255))
t.fillcolor(randint(0,255),randint(0,255),randint(0,255))
t.begin_fill()
while True:
t.forward(80)
t.left(162)
if t.heading()<1:
break
t.end_fill()

sleep(uniform(.1,.4))

Finished

<
[
[
|

Erganzungen:

Verwenden Sie anstelle von Sternen Kreise, Quadrate
mit zufallig erzeugten Radien oder Seitenléangen
Verwenden Sie fir den Stift und die Fullung Farben, o
Grundfarbe sind.

Programm: blumen.tns




Beispiel 4: GroBmutters Quilt

Verwendet die vorherigen Programme, nur dass die
Sterne (Quilts) ordentlich nebeneinander liegen.

from turtle import *; t=Turtle()
from random import randint
t.speed(10)
t.hidegrid()
t.hideturtle()
t.pensize(1)
forjinrange(112,-150,-84):
foriinrange(-169,170,86):
t.penup()
t.goto(i, j)
t.pendown()
t.pencolor(randint(0,255),randint(0,255),randint(0,255))
t.fillcolor(randint(0,255),randint(0,255),randint(0,255))
t.begin_fill()
while True:
t.forward(80)
t.left(140)
if t.heading() < 1:
break
t.end_fill()

Finished

Erganzungen:

* Ordnen Sie die Sterne so an, dass sie sich
sowohl horizontal als auch vertikal
Uberlappen.

« Andern Sie die Anzahl der Zacken der
Sterne.

* Verwenden Sie Kreise oder Quadrate
anstelle von Sternen.

Programm: quilt.tns




Beispiel 5: Buntglas
Erzeugen Sie mehrere Quadrate innerhalb von
Quadraten.

from turtle import *; t=Turtle()
from random import randint
from math import sqrt
from ti_system import *
from time import sleep
t.pensize(2)
t.hideturtle()
t.speed(10)
while get_key() !="esc":
n=200
t.penup()
t.goto(-n/2,-n/2)
t.pendown()
t.setheading(0)
foriinrange(10):
t.fillcolor(randint(0,255),randint(0,255),randint(0,255))
t.begin_fill()
for jin range(4):
t.forward(n)
t.left(90)
t.end_fill()
t.forward(n/2)
t.left(45)
n=sqrt((n**2)+(n**2))/2
sleep(.5)

25

Erganzungen:
o Verandern Sie die Anzahl der
Quadrate.
o Andern Sie den Drehwinkel.
o Erzeugen Sie ein Kachelmuster aus
Quadraten, die aussehen wie das
Original, aber kleiner sind.

Programm: buntglas.tns




Beispiel 6: Schwerpunkt eines
Dreiecks

Erzeugen Sie ein Dreieck mit den
Seitenmitten, den
Seienhalbierenden und dem
Schwerpunkt.

from turtle import *; t=Turtle()

# Mittelpunkt einer Dreiecksseite
def midpoint(pt1,pt2):

return ((pt1[0] + pt2[0])/2, (pt1[1] +
pt2[1])/2)

# Einen Punkt zeichnen
def plot_point(pt):
t.penup()
t.goto(pt)
t.pendown()
t.dot(3)

# Eckpunkte des Dreiecks
vl = (25,75)

v2 = (-125,-75)

v3 = (100,-50)

# Berechnung des Schwerpunktes sp
sp=((v1[0]+v2[0]+v3[0])/3,(v1[1]+Vv2[1]
+v3[1])/3)

# Berechnung der Seitenmitten
mid_1 2 = midpoint(vl,v2)
mid_2_3 = midpoint(v2,v3)
mid_1_ 3 = midpoint(v1,v3)

# Dreieck in schwarz zeichnen
t.penup()

t.goto(vl)

t.pendown()

t.goto(v2)

t.goto(v3)

t.goto(vl)

# Die drei Seitenhalbierenden in griin
zeichnen

t.pencolor("green")

t.penup()
t.goto(mid_1_2)
t.pendown()
t.goto(v3)

t.penup()
t.goto(mid_2_3)
t.pendown()
t.goto(vl)

t.penup()
t.goto(mid_1_3)
t.pendown()
t.goto(v2)

# Schwerpunkt in rot zeichnen
t.pencolor("red")

plot_point(sp)

# Die Seitenmitten in blau zeichnen
t.pencolor("blue")
plot_point(mid_1_2)
plot_point(mid_2_3)
plot_point(mid_1_3)

Finished
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Ergdnzungen:

+ Andern Sie die Koordinaten
eines Eckpunktes und
beobachten Sie das Ergebnis.

Programm: schwer.tns




Beispiel 7: Rautenstern
Eine Raute wird um den Ursprung rotiert. Dabei wird jede

Sekunde ein neues Bild erzeugt, bis [esc] gedrickt wird.

from turtle import *; t=Turtle() from time import sleep
from random import randint t.speed(10)
t.hideturtle()
t.pensize(2)
while get_key() |= “esc”™
t.pencolor(randint(0,255),randint(0,255),randint(0,255))
t.fillcolor(randint(0,255),randint(0,255),randint(0,255))
t.begin_fill()
for I in range(10):
for j in range (2):
t.forward(50)
t.right(60)
t.forward(50)
t.right(120)
t.right(36)
t.end_fill()
sleep(1)

25
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Erganzungen:

* Verwenden Sie ein Quadrat anstelle der
Raute.

» Lassen Sie einen Kreis rotieren.

» Andern Sie die Anzahl der Objekte, die um
den Ursprung rotieren.

Programm: raute.tns




Beispiel 8: Rechteck-Muster
Erzeugen Sie zufallig verteilte unterschiedliche

grol3e Rechtecke, die solange gezeichnet werden,
bis [esc] gedrickt wird.

from turtle import*;t=Turtle()
from ti_system import *
from random import randint
t.hidegrid()
t.speed(10)
t.hideturtle()
t.pensize(1)
while get_key() !="esc":
t.penup()
t.goto(randint(-200,150), randint(-120,100))
t.pendown()
t.pencolor(randint(0,255),randint(0,255),randint(0,255))
b=randint(5,60)
h=randint(5,60)
for i in range(2):
t.forward(b)
t.1eft(90)
t.forward(h)
t.1eft(90)
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Erganzungen:
*  Fullen Sie die Rechtecke.
¢ Verwenden Sie Quadrate anstelle von Rechtecken.

Programm: recht.tns




Beispiel 9: Buffons Nadeln

Simulieren Sie Buffons Nadel-
Experiment.

from ti_system import *
from random import *

#Sie starten zunéchst in der Shell,
#bevor Sie in die Turtle-Umgebung wechseln.

clear_history()

length=int(input("Laenge einer Nadel oder
[enter] fuer 50 ?")or '50")
spacing=int(input("Abstand zwischen den
Linien oder [enter] fuer 50 ?") or '50")
needles=int(input("Anzahl der Nadeln oder
[enter] fuer 1000 ?") or '1000")

the_pies=[]

the_count=[]

# Einstellungen der Turtle-Umgebung

from turtle import *; t=Turtle()
t.hidegrid()

t.speed(0)

w,h=get_screen_dim()

# Liste der x-Koordinaten aller Linien
the_lines=[]

#Anzahl der Linien
n_lines=int((w/spacing)/2)+2

# Anzahl der Nadeln, die eine Linie schneiden
crossing =0

# berechneter Wert von Pi

estimate =0

# Zeichnen aller Linien
for x in range(-

n_lines*spacing,(n_lines+1)*spacing,spacing):

the_lines.append(x)
t.penup()
t.goto(x,-h/2)
t.pendown()
t.goto(x,h/2)

# Zeichnen der Nadeln

for i in range(needles):
x1=randint(0,w)-w//2
yl=randint(0,h)-h//2
angle=random()*360
t.penup()
t.goto(x1,y1)
t.setheading(angle)
t.forward(length)
x2=t.xcor()
y2=t.ycor()
t.pencolor("red")

# Beruehrt oder schneidet
eine Nadel eine Linie?
fornin
range(len(the_lines)):
if((x1<=the_lines[n] and
x2>=the_lines[n]) or
(x2<=the_lines[n] and
x1>=the_lines[n])):
t.pencolor("green")
crossing+=1
t.pendown()
t.goto(x1,y1)

# Buffons Formel

try:
estimate =(

2*length*i)/(crossing*spacing)

except:

pass

the_pies.append(estimate)

the_count.append(i)
store_list("n",the_count)
store_list("pie”,the_pies)
error=(pi-estimate)*100/pi

print("Schaetzwert fuer Pi =",

estimate,"\nFehler =
" error,"%")

Finished

Python-Shell 717

>>>| aenge einer Nadel oder [enter] fuer 50O ?
Abstand zwischen den Linien oder [enter] fuer S
07?

Anzahl der Nadeln oder [enter] fuer 1000 ?
Schaetzwert fuer Pi = 3.117004680187208
Fehler = 0.7826595015267083 %

>>>|

*buffon's n..dle

X
1000

Ergadnzungen:

+ Andern Sie die Nadellangen
und den Abstand zwischen
den Linien.

Programm: buffon.tns




